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ABSTRACT

This project presents an automatic payment system though RFID card to
make payment easier like a smartcard. The program design that can order food by
pressing a keyboard then the program sends command to microcontroller and uses
microcontroller to control LCD and RFID reader on a customer side. Personal

information and balance saves in database.
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2.4 aduwvzluszuvaisionlen
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Tun1sdeansiialy dmsuaduniveildiulussuvenfienlenoraudseenldiiu 3 gy

audldaumdn Tun
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1) g7uANUdeT (Low Frequency) Mndn 150 Alatdsnd

2) ﬂ'ﬁummﬁgq (High Frequency) 13.56 wingidsnd

"

3) ghuanudigadia (Ultra High Frequency) 433/868/915 wingidsad
74 1 o ° a Voo P - 2/
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a a « o a a ¢ o 2 a v = i )
Anzi8504 wazAud 5.8 Anuidsed ieldiundeanisssezaunlnania 10 was Wudu

b

Aagun 2.8

125kHz, 133 kHz 13.56 MHz 2.45 GHz

915 MHz
6.8 MHz 433 MHz 5.8 GHz

R v N = e

10kHz 100 kHz 1 MHz 10 MHz 100 MHz 1 GHz 10 GHz

o & o - %)
JUN 2.8 Anudehuiisyuvensienledignldan [1]
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2.5 aregneanisuszendldauszuvansionled
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JUN 2.9 ssuumuANMSHIEI88N (2]

2.6 Nsldeulusunsuegdlu (Arduino)

o1pdlurelilasreulnsainesulianis Suaunsovinedlnglduuudisinng
Wawer ALY visamsadomldine #5110 Haruasldauns annsmhluldaou
valuvdeuuugsialdlngliisiondornduans Wusuuuuiiifeyauniiaauudumesiin &
MsRAILY insedfetianning wasausoldidadoulusunsuldiatoulusunsy
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2.6.1 Tupaunsldaulusunsueigdly

1) Weulusunsuuumeuiumes lngailnanlusunsuengdlu ain

http://www.arduino.cc/en/main/software

2) ovesaiiiupeufiames gy 2.10

at

Y - 1t =
3) \Walusunsuengdludasiianuuedisgy 2.11

@ sketch_feb02e | Arduino 105 0 ; |2 0 ]
File Edt Sketch Tools Help _

OO MER &

sketch_feb02a

4 v 1 - 1
U 2.11 nihwnllsunsuenndli

cafl
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) fmuavesansidaulrinsefuuesauasnosnitlday fograr

U212

sketch_feb02a | Arduino 1.0.5

File Edit Sketch ETools Help

F Auto Format Ctrl+T

Archive Sketch Arduino Uno

sketch_feh023 Fix Encoding & Reload Arduino Duemilanove w/ ATmega.
Serial Monitor Ctrl+Shift+M Arduino Diecimila or Duemilanove

Arduino Nano w/ ATmega328

et i Arduino Nano w/ ATmegal68
i "' e  Arduino Mega 2560 or Mega ADK
Programmer » Arduino Mega (ATmegal280)

Burn Bootloader

=l
JUN

Arduino Leonarde

| Arduine Esplora

2.12 MSAVUAUDSALATNEIANS bUATU

2 d“ A U s
5) Weudoyaasluiuiing aslugd 2.13

€D sketch_feb02a | Arduino 1.0.5

File Edit Sketch Tools Help

-1

Q0O I

sketch_feh02a §

#include <LiquidCrystal.h>

LiguidCeystal led(l2, 11, 5, 4, 3, 2):

vold setup()

{
Serial,begin(9600);
led.begin(l6,2);
lcd.nodutoscroll () ;
led.print(“WELCOME")
led, secCuxsor(0,1):
led.princ("Selectlten: ") ;
delay(1000);

)

void loop () (
char input;
delay(100);

Me

@a ADK on COM4

o A

Sudsuteya



6) naduiiansvaeumNgnADdLarAaxlng (Compile) 1An

Wswnsuagdluilensinasunnuianainvadlan lnenisnadunagy 2.14

sketch_feb02a | Arduino 1.0.5 ; : e B (S

sketch_feh02a

{

}

#include <LiguidCrystal.h> -
LicuidCrystal led(12, 11, 5, 4, 3, 2);

void setup()

vold loop() (

Serial.begin(9600);
led.bagin(le,2):
led.nosutoscroll ()
led.print("WELCOME™) ;
lcd.setCursor(0,1):
led.print("SelectIten:")
delay(1000);

char input;
delay(100);

5B e N muend Valed e A A 0% T

Arduino Mega 2560 or Mega ADK on COM4

et Bt —

< a ° &
EUV] 2.14 AM9R9I9FUANUNANAIAUDIAEN

14



7) nlnandeya lngnisnadudagy 2.15

sketch_feb02a | Arduine 1.0.5 : % =B

File Edit Sketch Tools Help

sketch_feb02a §

#include <LiquidCrystal.h> -
LicguidCrystal led(l2, 11, 5, 4, 3, 2):

volid setup ()

{
Serial.b=gin(9600);
led.begin(lg,2):
led.nosutoscraoll();
led.prine ("WELCOME™) ;
lcd. getCursor(0,1):
led.princ("SelectIten:™);
delay(l000) ;

void loop() {
char input;
delay(100)

SR DEINE T S ST e gy s e

Arduino Mega 2560 or Mega ADK on COMS

ﬂJ s kel
UM 2.15 m3dnivandeya

15
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8) \iledninandayadiia wlutonnuidnlnandusa (Done

o

uploading) s3y 2.16
sketch_feb02a | Arduino 1.0.5 . 1 et ! -

sketch_feb02a §

#include <LiquidCrystal.h>

.I’

(]

LiquidCrystal led(l2, 11, 5, 4, 3, 2):

|| void setup()

{
Serial.begin(9600);
led.begin(l6,2);
led.nodutoscroll(); I
led.print {("WELCOME") ; |
lcd. secCursor(0,1):
led.print(“SelectIten:");
dr1lay(1000);

)

void loop() {
char input;
delay(100);

f Done'upluadlng.

Binary sketch size: 11C

Arduino Mega 2560 or Mega ADK on COM4

U 2.16 winsadiedwivandeyaduia

v

2.7 Ms3an1sgrudayatngieaauaalas lflUsunsuuaw@sn (AppServ)

arilvanlusunsuuongsniiuled http://www.appservnetwork.com

TneLdonasTuNADINISAARS
Y . "
2.7.1 YuUADUNTANNIUSLATULDWLT W

1) duilandnlWd appserv-win32-xxx.exe LNaYiIN15AARAY 1Y

Usinguinaemugu 2.17
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" Appse atup

Welcome to the AppSery 2.5.7
Setup Wizard

This wizard will guide you through the installation of AppSery
2.5.7.

. It is recommended that you close all other applications
before starting Setup. This will make it possible to update
- relevant system files without having to reboot your

o computer,

Click Next to continue,

13
s

SUN 2.17 JunpumsAnaslusunsuwawds (9]

L7 J v s A 1 2 1 - ﬂ‘j 3 1 1 i
2) mnwausuleulibinadaluiieidrgnisfansludunely usinina

| w o v a P -l af o W o d
INUQHSUNI?}H‘LTJ‘LWﬂﬂUﬂLﬂﬂ Lwaaaﬂﬁ]’lﬂﬂ’ﬁmﬂC"NIUiLLﬂiuLLaWL'ﬁ'ﬁwm'ﬁ?’Um')ﬂquw 2.18

e [

E}Appﬁerv 2.5.7 Setup
g

Press Page Down to see the rest of the agreement,

License Agreement
Please review the license terms before instaling AppSery 2.5.7.

GNU LESSER GENERAL PUBLIC LICENSE ﬂ
Version 2.1, February 1999

Copyright {C) 1991, 1999 Free Software Foundation, Inc.

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

[This is the First released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.] i

If you accept the terms of the agreement, click I Agree ko continue, You must accept the
agreement to install AppSery 2.5.7,

Mullsoft Install System va, 19

< Back I I Agree I Cancel

P - o a o
g‘tJ'w 2.18 swaridunaulunisinm [9]
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v & a o v a o | e w
3) L'U"IQ'UUNE)Uﬂ']ﬂaaﬂﬂa’lﬂ'ﬂ'lﬂwmﬂﬂfﬂﬁmﬂ(ﬂ‘ﬂ Iﬂﬁ]ﬂ"lﬁumuuajﬂ'ﬂqﬂ

] v ]
s

Aa v a da & v - o v
Vmﬂmﬁf\]glﬂu C:\AppServ MINABINTTIUALUURIEN N AAA lﬁﬂﬂkaaﬂUaWUW'}QﬂﬂaQﬂqi

<

d = : v ] o J 2/ ls = Q‘:’ ﬂ’: ]
AugUR 2.19 WadenUaremaaiadulinadudnluieiigiuneunisinndunely

M\ appSery 2.5.7 Setup

r - P Choose Install Location
\ & Choose the folder in which to install AppServ 2.5.7.

Setup will install AppSery 2.5.7 in the following Folder. To installin a different folder, click
Browse and select another folder, Click Next to continue.

~Destination Folder

| C:\AppSery Browse... l

Space required: 48.6MB
Space avallable: 5.5GB

nullsaft Irmstall System v2,19

< Back I Next > I Cancel I

(] v

U7 2.19 i@enuatgnienisinsalusunsaiewdsy [9]

a) FenufimnanouTniusiiidoanisinda Tnordusuiuaylhiden
amnuianausnhiglinudesnisdanatiemzuianaiaunsadenauden
feaniseen Inuseasidenudasuimnadeai

- Apache HTTP Server fie TUsunsudiviwmiidusuidsmies

- MySQL Database fie Tusunsuiivimiiduadivadiniaes

- PHP Hypertext Preprocessor fia Wiknsuiiviuiiusesiana
NISTUVRINIRLDUN(PHP)

- phpMyAdmin A TWsunsuildlunisusmsdansgudoyaus
oaRLead vl

dovhmadenufiainamugui 2.20 Beudosudlinadaluiiain

p 17
as

dUuneunsinsssioly
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I AppSery 2.5.7 Setup e ‘ A ] S

r i Select Components
! Select the components you want to install, clear the components

you do not want to install,

AppSery Package Components

IV Apache HTTP Server

¥ MySQL Database

¥ PHP Hypertext Preprocessor
¥ phpMyAdmin

nullsoft Install Systema2i 19

< Back I Next > | Cancel |

= ea v a U
U7 2.20 (Fonuiininaneulnnuyiigesn1singa (9]

5) fimuaAnsuNnuetazundLIUEs e slagmenuviaiug 3 dwu
< P
AINFUN 2.21 D
o 0w o AN oy ¢ )

Server Name Aaveadmiulaudayateiiu@iniieiveyiu
LU www.appservnetwork.com

Admin Email Aetasdmiutoudeya Budgpuassuu i
root@appservnetwork.com

o = 1 o a L3 A = 2/

HTTP Port Aadesdmiusvyneivitaziiunldeupsundiiy
\@sneslaeniluuarnzilrimdnde 80 winddeanmdnideanisldwesv 80 Aauisa
wiluldmniimsdsundameinmsidilduiuginnesua ynassiGonldaivied
o & av T | P 2 ¢ v g ¢ Y v
Induidassyymanaauwesnimg Wy wmndenlinesngg lunmsidnivladvnasssesly

http://www.appservnetwork.com:99 Jsagamnsaidildaula
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ﬂ AppSery 2.5.7 Setup e ‘ ot ”}'ﬁ; ‘ - |DI_3(_]
Apache HTTP Server Information
Please enter your server's information,

Server Name (e.g. www,appserynetwork,com)

I localhost

Administrator's Email Address (e,g, webmaster@gmail,.com)

I root@appservnetwork.com

Apache HTTP Port (Default : 80)

[

Mullsoft Install System v2,18

< Back ’ MNext > I Cancel I

= o i a ! o
JUN 2.21 mstmuampeuiindnezundiiu@sviies (9]

6) NMUUAAIADUNNUDIUELOAALDAAN AL DUAAUNINUA 3

Rl

| al
du Mugun 2.22 fie

Root Password fiavesdmivdeu sviaunmadnldaugudeya

o & o o

983 Root Miagguaszuvassiiilduguteyaludnuasiidudguassuy Iisey user fie
root
Character Sets THlumsimundssuunmuililunsdaiv

gudaya, Fesdduguteys, iiingiudeys, dswengudoya, Aasegiudoya



™ AppSery 2.5.7 Setup

m MySQL Server Configuration
Configure the MySQL Server instance,

MysoLt

Please enter Root password for MySQL Server,

Enter root password

Re-enter root password

I ssseed

MySQL Server Setting
Character Sets and Collations

[UTF-8 Unicode |

¥ 0ld Password Support (PHP MySQL API function.)
[~ Enable InnoDB

ullsoft Install System vy 9=

< Back I lnsta" l Cancel I

ﬁt o ! - - L
EU‘/I 2.22 MIMyUAAIABUNNYBIBLEaRILEaRAWUE [9]

21

7) dugatunaunisinaalusunsuuemdswdmivtunaugaiaiiazdl

Widendeansashitimssurunduazineoafusariuiivsald antunaduasduie

Ay Y 3 a ar -!l
La%ﬁlaumsmmmwsLmsuuawmimqgw 2.23
£ AppServ 2.5.7 Setup 4 U PR A gl £ b '@.?’EZ:‘T : |D|_¥_[

Completing the AppSery 2.5.7 Setup
Wizard

AppServ 2.5.7 has been installed on your computer,

Click Finish to close this wizard,

[V Start Apache

[V Start MysQL

B

WWW . APPSErVNe EWO FK (oI

« Beck I Finish l Cancel '

JUN 2.23 wihtuneudugansAnnalusunsunwewasv [9]
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2.7.2 msdamsgudeyanneadfuaa

1) wihaelusunsunendsvinaith phpMyadmin fasudi 2.24

") AppServ Open Project.Z.t' x \
. 7 C [ localhost8080
i Apps DB 0K 4 D owedwi ) TEECOM 4 BE mail [§ Load

The AppServ Open Project - 2.6.0 for Windows

bgghpMyAdmm Balahase Managm Version 2.10.3 I
a7 nformation Version 6.0.0-dev

About AppServ Varsion 2 6 0 for Windows
AppServis a merging open source software installer package for Windows includes

* Apache Web Server Version 2.2.8

* PHP Script Language Version 6.0.0-dev

* MySQL Database Version 6,0.4-alpha

* phpMNyAdmin Database Manager Version 2.10.3

Changelog

README

AUTHORS

COPYING

Official Site : http /fwww AppServNetwork com
Hosting support by : htip/www.AppSarvHosting.com

Change Language : e M

LI I T Y

# Easy way to build Webserver, Database Server with AppServ :-}

U7 2.24 mishalusunsuuandsv

2) wielusunsy phpMyadmin aadenduldily ﬁ’ag‘dﬁ 2.25

) phpMyAdmin 2103 - loc

<« X Li"i;:éalhosﬁtifjad,lphpM,-Adminf \
T Apps o x t[ﬁ’ Load

Authentication Required

The server httpi//localhost:8080 requires a username and
password. The server says: 0,

User Name: root

Password: |~~~

LlogIn Cancel

U7l 2.25 wislusunsy phpMyadmin
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L3

% %) a o v l v ow -
3) ﬂ'ﬁqqﬁqu‘ﬂaﬂ;llaiﬂﬂﬂ'ﬁﬁﬂu’ﬂaﬂ E)\'lﬂ']'i'LLa']ﬂmquﬂ'i'NﬂﬂEﬂﬂ 2.26

w44 localhost8080 / localhost X

& - ¢ [ localhostEa80/pholyAdming
i Apps rF R ° B a Dwedwi 5 TRECOM & BY mail | Load

T Do you want Google Chrome to save your password? I Save passwordi ] Never for this site

localhost phpMyAdmin - 2.10.3
phpiduAdmin &3 Server version. & 0.4-alpha-community-log » MySQL client version: mysgind
» Protocol version 10 » Used PHP extensions: mysql
4BBEQ0O 8J Server. MySQL host info: localhost via TCPAP  Language @ : English
Database » User: root@localhost & Theme / Style Original
(Databases) ) v [ IMySQL charset UTF-8 Unicode (utf8)

- » Fonl Cl 9 v |
[H MySQL connection collation [utf8_unicode_ci @ size: | 100%
[22] phpMyAdmin documentation

8 phpMyAdmin wiki
& official phpMyAdmin | lomepage
» [ChangeLog] [Subversion] [List:

Please selecl a database

& Create new database @

" [Collation 7 7 711 Creale|

H show MySQL system vanables @
% Processes @

[ Character Sets and Collations

%) Storage Engines

¥ Reload privileges @
 Privileges

i Databases

& Export

& Impont

B Logout @

sUf 2.26 maadugudayalmilulusunsy phpMyadmin

v [J 1 d v a ﬁJ
a) fﬁ’]xﬂFI'W'NLLﬁSﬂWU?U‘UﬂQWﬂBQﬂW?ﬂQ‘EUW 2.27

it localhost:8080 / localhost X\

YhpMyAdmin

C |} localhostBOS(

A B D B Bl Al [Dowedwi [ TEECOM & B mail [§ Load
g Server:localhost » (@ Database: test

Jﬁs"uclum JS2S0L  rSearch gOuery @EyExport Timport gowral.kmi &b Privileges 3¢ Drop

BhpssyAdimin
AEBEDED (D Database test has been created.
Database Wy rSQAL query:
3t (0) ) v | | CREATE DATABASE ‘test
to)

tables found in database

No tables found in database

r ‘ull Create new table on database test
Hame: ftest1 Number of fields: [3

gﬂﬁ 2.27 158519113190 phpAdmin
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n’.’r 1 1 1 ' v a o =
5) Mamusartosinuanatuiin Aigun 2.28

L localhost:8080 / localhe:

C [ localhost 2080/ phpMyAdmin
apps @ O B Hoa [ ovedwi (5 TELECOM & B mail |§ Load

£ Server: localhosty [ Database: test) (i Table: testi
et S

Field Type D LengthValues! Collation Attributes Null Defaul2 Exti
phpiduAdmin T [ | " | I [metoun v [ [auto_incre
AE@OO0 pame  |varcHaR [ po | [notnun v | il
[age |vARCHAR Y| R LAif 1 [notnui v ]| [
Database

it (0) 4 Table comments: Storage Engine: @ Collation:

B [ | Mp1SAM v | v
o)

tables found in database

save ¢

7 f field type is "enum” or "set", please enter the values using this format: a' ‘b’ ‘¢’ .
(6] If you ever need to put a backslash ("\") or a single quate (™) amongst those values, precede it with a backslash (for example "\wyz' or 'a'b')

2 For default values, please enter just a single value. without backs!ash escaping or quates, using this format: a

@

5U 2.28 n1sisrns19lu phpAdmin

D2 P 3 v ow -
6) nipadioasamsiaaiands Agua 2.29

i Focanort 3080 / lacather X ! g L) & dbied
€ = C [localhosteds A

50, phpkyAdming

[

Hoapes B OB T G @ L owele [ TEECOM & B malt [ Lead
34 Server:localhost » s Database: test » 5 Table: tasti

MiBrowse pfstucturs JPSOL  j Search §einen fEExpoct [flimpant §8Oparations [ffEmpty e 0rop

phplifzmin
ABBDROD (D Table ‘test’ "test1” has been created

Database [ SQL query
a8t (1) v

CREATE TABLE sty
1T 1041 HOT HULL AUTO_INCREMENT PRIMARY KEY ,
name 30 HOTHULL
test (1) age 44171402 HOT NULL
ENGINE = MYISAM
et

[ E6it)| Create PHP Code |

Field  Trpe Coletion  Attributes Wul  Defauit Extra

" e e ao_nersment [l 2 X
 neme varchand0) ud_general_ci Hie msx

oge  varchan2)  utd_gensral_oi Mo m ., X
1 CheckAll/Uncheck Al Withselected. ) » X ® W ®

o Prnt view J& Propose table structure @

# A [ fieldis) « AtEndof Table Al Beginning of Table [ After i@ v| | Go
Indexes: @ Space usage Row Slatistcs.
Keyname Type  Cardinsiity Action Field Typs Usage  Statements Value
PRIMARY  PRILARY R Deta 0 8
Create aningexon ({7 colomar g | Indax 0 B
Tosl 0 8

- Y i P 1 [
UM 2.29 U phpMyadmin Woasamsaasaudn
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= i a v i [ [ o
7) @enuau insert Weudoyaluyed value uinm go AIguT 2.30

sida localhost:8080 / localhost x|

* C' [ localhost3080/php /
i Apps oK B2 @ )i [ TELECOM & B mail | Lead

gl Server:localhost » (i Database:testy ([ Table: testd

_msruwu g Structure 73 SQL ;,Snarcnl irilﬂllﬂlmsxpon fifgimport 4% Operations mtmmv D Drop

v Admin
PRDEES Field Type Function Hull Vaiue
R R N O — N |
name varchar(30) | o |
Database s— fest
| test (1) v age  varchar(2) X e ﬁ__
test (1) | lgnare
st Field Type Fun_cauj o Hull ke Value
id int(4) v [1002
name varchar(30) ) A\ ftest2
age  varchar(2) v ﬁz—" -

Insertas nawrow v | Andthen | Gonackio previaus page ¥ |

v [ el

v

gﬂﬁ 2.30 Yesdmivluiindeyalu phpMyadmin

v N , o v Y v v ow =
8) UMY phpMyadmin IUaU8YagAUUNALTIUTABLAT AIFUN

231
B et e L

L € [ localnost My Alp
Paop B O B B A U e C TRECOM & B ml 19 Lead

m

£ Server localhost b g Database:test» [ Table: testi
[MProwss pgswucwre JPSQL o Search Filvsen g €xport Rgunport 48 Operavens gty (aOrop

phpidyidain
48000 (D Showing raws 0 - 1 (2 total. Query took 0.0008 sec)
Database
st (1) v [SOLquery
SELFCY *
test (1) {m: ¥’ y
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2.8 N15hulUsNsUITIaURN
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g Visual Studio
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2) ahaanilmilasmsnslusianlmi (New Project) fagudl 2.33

B start Page - Microsoft Visual Studio (Administrator)

FILE EDIT VIEW DEBUG TEAM TOOLS TEST ARCHITECTURE ANALYZE WINDOW  HELP
8 - W b Attach.. - ¥,
CET N A I Stort Page & X
Search Toclbe 2 -
4 General GET STARTED HOW-TO VIDEOS (STREAMING) LATEST NEWS

There are no
usable controls in
this group. Drag
an item onto this
text to add it te

Learn more with these short streaming videos:

} How to multi-task
with My Work

h?*’ Using Code Review
to improve quality

Improving quality
th unit tests and

the toolbox.
& Visualize the impact | Using layer diagrams
of a change to design and
validate your
Recent architecture
& Easily testing user ) Load testing i)
intesfaces with applications in Visual
Coded Ul tests Studio
o v :1 IL I a
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o 2 & 1 2 I P o =
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4 Visual Basic |
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]
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/
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i Sitverlight Class Library Visual Basic
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[ Create directery for selution |
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Background Tite
Curser Defaule
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JUn 2.37

D testt - Microsoft Visual Studio (Administrator)
FILE EOIT VIEW PROJECT BUILD DEBUG TEAM FORMAT TOOLS TEST ARCHITECTURE ANALYZE WINDOW  HELP
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7  DirectoryEntey
P DirectorySearcher
[E DomainUpDown
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B FileSystemWatcher
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| al o oo -l
Wﬁqﬂwﬁ']&lEULL‘UU LYY LUUTIBUSTIUAT LUU Cross Tab BASLLUUBDUS) YIULATRIIEN

ponuuuIlihedansldiu waznsinderugiudeyaanunsavitldvannvane aiunseu

Taya9n Viewer vadaiaungld Gelinnuanunsaiivainvals waens View fiawnse

View lavannuane 1oy n1s View fiusialusunsuied n1s View eulusunsuiidulusunsy

Usegneil Software House AN HARTLL ¥TaQUIY

2.9.1 Aunauns lYUlusuNSUASERaI WY

L2 £ EJ £ 2 o ‘I‘J at ﬁl
1) @NFIUVBYAAUNADINITNITIEAUVUN AIFUN 2.39

e+ id_user
@il XK 1001
L) (72 25300
g o X 1001
O = K 1001
B P X 1001
A
§ &7 X 1001
L g 1001

name_menu
Big Burger
Big Burger
ChickenMNuggets
FreshSalad
FishBurger
ChickenMNuggets
FriedChicken
FrenchFries

price number amount

50
50
50
60
30
50
30
55

1

=< W N W

50
50
150
120
180
150
60
55

date_order
2014-03-04
2014-03-04
2014-03-05
2014-03-05
2014-03-05
2014-03-05
2014-03-05
2014-03-05

JUN 2.39 wiheauanenisas g uTeyaifedn1svinT e

time_order
12:31:38
12:21:12
14:54:32
14:55:46
16727
15:26:43
15:29:09
15:31:56
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2) @311 dataset lagAdnuITl project > Add > New Item U

Seliston Faplos

@ o-f0dB o FR

Search Sehition Erplerts (G v p-

551 Salution test' (1 project)
Rebuild 9 App.cantig
Chany [ Farmlsb
©  Publish..
Run Code Anabytis
Scopete This
B Hew Solutson Explorar View
Caleulste Code Metrics )

2 - A - Cirleshited
Ackd Reference. o g Rem... SheAReA
Al Service Reference... W New Folder

B Manage NuGel Prekiges. W wiecows Ferm..

*g View Clmss Dingram T UserCantral.

£ Set o SudlpProject D Component.. 5
Debug v Module..

il Add Salutica te Seurce Control . W G Shift AleC
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X Remove ]

kv Remame
Unload Projest

. Open Folder in File Explorts

G‘ v 1 v LS
Ul 2.40 wihanauanIn1sasanmgn
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3) aan data > dataset MMMUATEFIUTDYA INUUNA Add A3y

| 4 Installed Sort by: Default Seurch Installed Tempiates (Ctil-E) p-
i a Cnmmo: ftems @ ADO,NET Entity Dats Mcdel Common Jtems. Typs: CommonKems
| w o A DataSet for using data in your
! = .
I ‘ - DataSet Common Remw application
eneral 2
Web
b o, W 4] e 5 DeConte Generater Common ltems
Reportin:
Wonl.ﬂuv? 6:1: LING to SQL Classes Commen ltems
WPF
Graphics i Local Database Commean Items
¥ Online i Servicerbased Database Commaon ltems
‘D XML File Common ltems
»
[ L schema Common ltems
-
EL; XML Te Schema Common ltems
g"!" ASLT File Common Items
Name: OataSetad 3

o
sUN
Y
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4) TUsunsuagyinsas1aminmng dataset Yuun Wiednvluntinsng
Winm Add > TableAdapter fis3u 2.42

1 5

* TableAdapter...
» “trl+ DataTzable '

]
Paste

elect All tri« A Query...
Show Relation Labels = Relatior
r view Data...
<> View Code F7
& Properties Alt+Enter ¥ to visually create and edit typed d
Drag uatavese ieins o server expiorer wr inie vataset Toolbox onto the design surface

‘d L4 1 ﬂ‘$ 1 2/
UM 2.42 nisauanansaerlungingn

o A L IJ 2/ ﬂl ' 5 -
5) NINTTLEANTIUVBUAVADINTTLTBUAD INUULADN yes Lasnm
Next a3y 2.43

Choose Your Data Connection

Specify the connection string required to connect to the database.

Which data connection should your application use to connect to the database? L R— - ——_—
| my_project! ConnectionString (MySettings) . [ New Connection., )

n stnng appears tocontain sensitive data (for example s password), which is required to.conneéct to the
stonng sensitive data w the connection string can be a security risk, Do you want to include this
onmestion strng

udesensitive data fram the cannection string. I will set this informattonsnmy application code

g5, nelude sensitive data in the connection sni::g.

Connection string that you will save in the application (expand to see details)

‘J i/ J @
JUN 2.43 mhsauaaenisidenguteya
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_A Installed Sortby: Default H "E—E']

4 Common ltems T
Code 2 Fyp | Crystal Repoas bl
Data
General E Repert

Common ltems
Web

Commen ltems

Graphics

P Online

Name: CrystalRepert.rpt

Search Installed Templates (Ctrl+ E) o

Type: Common ltems

A Crystal Reports file that publishes dats
to a Windows or Web form

lﬂl £ 1 o d v
E‘UVI 2.44 WINANUARINITAINUATE TS89
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Create a New Crystal Report Document

(.!“'! 1 @ Using the Report MZID

D ) As a Blank Report

@ () From an Existing Report

[#{Cross-Tab

Mail Label

Ay

8) \enguleyafisiaan1suanslusiey gy 2.46

I S v
Data
Choose the data you want to report on.

| Y o
| Available Data Sources:

JUT 2.45 wihsnauanennsidengukuun1suanIng

Selected Tables:

—_
=)

1= [_JADO.NET DataSets
=) r’,; test,DataSet
R orderl
& [Z3.NET Objects
@ My Connections
1+ __JCreate New Connection

&

3 DataSet
@ orderl

Cancel

J |

Help

)

o v ° - » o v
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E plaltadl ¥ Cystrifepartpt 8 X DataSetusd” FormL.vb [Design] -
o B N O O D D L O O s e e O O T R I 1
B X Formula Fields [ Sactinl 3
8 (2 Parameter Fields bk ‘M R PSR - P P A LA S
o | B Group Name Fields v Section2 (Page Header
I':V ' & Running Total Fields ’ jm.Secten P 1
g\ t F Special Fields !_‘ Print Date |
§ 0 S umeunar E i y .y .
|2 |pamse me . hrce ., Dumoe . amoun . date orde
S T — e s i
| |pame_menu . price . pumger . amount . date_order
oz Sectond Bepot Foutac doy S . Siiaac .
L asons oge P : i s
o e
_i j& Numbej

‘J £ J ° o/ v
EUV] 2.47 MR NENATUETNTIEUY
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10) yhmssulusunsufinglfisuuuuvessisaunuiidamuall dagu
2.48

¥ Save data in the repon

| & S[E) e 171 U~ U AP CRATAL HENONTE
! | -
18/04/2014
Navy 5221 12,331 6,429
Aqua 22,856 25.935 20,836
Fuchsia 23.523 27.914 9,580
White 2,625 5.864 0.014
Red 22,301 20.995 18,067
Olive 21,350 21,768 11,206
Blua 17.718 2721 13,422
Red 18,526 11,839 17,742
Teal 14,780 66848 12,383
Lime 29,183 11,869 25.207
! 4
|4 »

a v
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3.1.1.5 sanuvugrudeyaiildau

 customers | i
no_car |
id_user . — menu j
name_user price i
acidress no armount I

phone_riurnber menu _1_ date_order !
balance ‘ nurmber 1 time_order {
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Tek Prevu . :
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i 00110101 { 00110010 | 00110101 00111000 (00111860 | 1800010 0.
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BM1250 RFID READER / WRITER MODULE

Overviews
Designed for embedding inte products manufactured by third-parties, the BM1250
Module is a Jow cost 125Khz RFID card reader / writer in a printed circuit Board form

factor

. Ease-of-

Rapid Product ¢

. Automaticaily demaodulate and cecode RF signal and make the actual 139 data

ready.  No need to know about complicated REID subjeet

Supporis Atmel / Temic TS5 EM4100 compatibie and EM4102(Unigue

«  Supports Manchester RF/64, Manchester RE/22 moadulation

- Read Distance &< 15cm . typically 8 cm. {varies according to antenna & tags)

»  Small Form factor. unit size * 5 ¢t .35 cny

. instant port for 16 x 2 LCD display module, ready for display output reading data
from EM4400 compatibie-and EM4102(Unique) tags

*  Onhoard color LED (Red/GreenyTor Pass indication

«  On board Buzzer for Pass indication

» Estemnal RFID Coll Antenna (~860 uH)

* | UART (TTLInterace up {0 115200 bps (cefault 19.200)

= RS5.23

2 Interface (optionaljup o 115200 bps (default 19.200)

RE-232 Infertare toptonal)

Description

BM125D s designed to read and write the popular range of Atmel/ Temic T85xx EM4100 compatible and EM4102(Unigue) tags
cards and fransponders available an the general market.  EM4100 compatible transponders cantain 64 bits of Read Only memory, while
TS5xx transponders carry 224 bits of Read / Write memory,  The most used applications for the 125 KHz RFID systems is in ae=neral the
person identification. specifically access control, time & attendance systems, and the part identification i.e the immebiizer systems used in
automotive applications

BM1250 is one of the lowest cost RFID reader/ writar (ericodar) module with hign perfarmance and reliability for embecding to any
ihire-parties’ prejects when compare to other compatitors in the market.  The mogule is designed for easy to use. with serai communication
to the host devices eidher UARTITTL or R8-232 (optional through MAX 232 chip on the PCE's bottom side). By the special funclion, there
s a instant output port which can drive the data output from the EMA4100 tag reading directly to 16 x 2 LCD module without any additional
components need

BM1250 module necds a simple extemal antenna for driving magnetic field to passive RFID transponder, When they are within
range of the reader unit they are able to draw sufficient power from the electromagneatic figld 16 power their own internal electronics.  Once
pewerad they are able to modulate the Incident magnetic fisld which is detacted by the reader. In this way the transpanders are abla 1o
transmit their data to the reader.  The recommended inductance for the antenna is approximatehy 860 yH, customers can purchase from us
or request coll mformation for in-house producing

Binary Co., Ltd.

1351410 Prachachuen Read, Bangsue District, Bangkek 10800, Thalang
Tel: +66-2-9517520-3, Fax . +66-2-585-7803

Email; sales@binary.coth

URL: hitp:/www_binary.co.th



BM1250 RFID READER / WRITER MODULE

Electrical Specifications

Vdd Supply Voltage 475V1055Y
Digital Inputs to GND -0 8V 1o 5.5V
Operating Current 75 mA

Operating Temperature Range -A0C1085C
Storage Tempetature Range 55 Cto100C

NOTE: (1) Stresses above those listed under “Absolute Maximum Ratings™ may ¢ause pamanent gamage to the device Exposure to
absolute maximum conditions for extended periods may affect unif reliability

Connector Pin Description * intarface is via 6 line connection

Pin Label Description

1 +EV System power, -5V DC input

2 T 292 TXD (RS-232)

3 Rx_232 RXD (RS-232)

4 T T UART TXD (TTL levels only)

5 R¥_TTL UART RXD (TTL levels onty)

6 GND System ground  Connect to power supply’s ground (SND) terminal

Board Layout

Board Layout

16x2
LED Connaclar

\

Fower Supp'y und
Serigl Communication

Conneato!

O;E I8 wanineryeonn (3

O w20 ; e 1D RAb HHEE

Artanng Co

Connerior

Binary Co., Ltd.

133110 Prachachuen Road, Bangsue Distnct Bangkok 10800, Thailand
Tel : +66-2-8517520-3, Fax : +66-2-689-7803

Email. sales@binary co.th

URL: hitp:/ivavw.linary.co.th



BM1250 RFID READER / WRITER MODULE

Serial Qutput Format description

When a successful read of a transponder takes place the unil witl transmit a string of information. This siring
ofinfarmation will vary in length depending on the type of transponder being scanned, and the configuration of the transpondsr

EM4100 transpondsr Output

The output format for a read of an EMA100 transponderis @ simplestnng.of 10 ASC coded Headecimal characters followad by the
ASCI coce 30D (carriage return) as a sting end marker

For example, when reading a EM2100 compatible card with the Version Number of $06,.and a.card data of

S001259E3 the following string is transnutted:

OB8001258E3 «em> where <cm> [3senal ASGI code SO0

The card information is transmitiec-once and-a new string will not be sent until the transponder moves cutside of the scanning ranga, and
it, or another transponder enters scanning range agan

NOTE: Although EM4100 compatible transpenders contain G4ksits ofinformation not all the bits are defined for user data. Some data bits
are allocated as parity check bits and for ather functions

5 1] SO
The output format for a read of a TA5XX transponder is slightly more complicated than an EM4100 as ithas more data and various
options that aiter its behavior.  The memory structure of the TE5XX rfid tags is as shown In Fig 1. THEXX memory structure

Block memory description

Block €, 32 bit Configuration data

Blagk 1, 32 bit Used for Byte Track

Block 2, 32 bit R/wW Data

Block 3, 32 bt R Data

Biock 4, 32 hit RAW Data

Block £, 32 ht RW Data

Block 6, 32 bit RAW Data

Block 7, 32 bit R/\W Data, or Password

Fla 1. THEXX memory structure

Binary Co., Ltd.

1351/10 Prachachuen Road. Bangsue District. Bangkok 10800, Thailand
Tel : +66-2-9517520-3, Fax - +66-2-589-7603

Email: sales@hinary. co.th

URL: http:4hwww . hinary.co.th



BM1250 RFID READER / WRITER MODULE

EM 1250 Schematic Diagram

Interfacing to 16 x 2 LCD module
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BM1250 RFID READER / WRITER MODULE

Communication Protocol

BM1250 can read tag automatically and output tag data without requiring any stan read command. it sliminates use of
external microcontrelier.  So far. aute read mode has been used widsly In Industry.  When a tag enters into the RF field, it's data s
sent automatically through UART / R$232 to the Host / Terminal / PC or MCU, ther the host processes the tag data and perfoms

necessary action.

The communication between the host and the module can take place at 9800 bps, 19200 bps. 38400 bps. 57600 bps or
115200 bps N, 8, 1. The Medule communicates at 19200 bps, N, 8,1 as defaut.  Once the baud rate is changied using the
CMD_SET_BAUD command, successful camniunication will only occur with the naw baud rate.  The host first sends the command
and the module executes tha aperation and replies with a response to the command.  The host can analyze the reply to check if the
opsration wis successiul or if any error gecurred durning the operation.

Commiand Structure (From Host ta BM1280)

Following 1s the UART frame for the commands sent by the host:

Header Reserved Length Command Cata CEUM

1 Byte 1 Byte 1 8yte 1 Byle N Byte 1 Byte

Header ; This is a single byte that indicates the beginning of a frare.  This byte shouldbe always OxFF

Reserved : This byte is reserved for future Use and not implemented currenily, It neads 1o be always 0x01

Length : This byle is used to indicate the length of the payload data,  This includes the Command and the Data hytes
Command : This byte is used to instruct the module on what operation to perform

Data : These are parameters necessary for the module 10 exscute the command. For example, for 2 Read command, the
data will he the modulation type tobe read.  For a Write command._ this will be the Block number and block data to be
writen 1o the lag

6 C8UM: This isthe checksumybyte. This yte isused o the host as well as the module to check the validity of the packet

[5. 0 TCR S py

and to trap any data corruption. This is calculated by adding all the bytes in the packet except the Header hyte (OxFF)

Response Structure for Commands (From BMA250 to Host)

Following is the UART frame for the response packets sent by BM1250 module in résponse to the commands For most of the
comrmands that does nol require parameter frorn BM1250, there = only one response indicating the cornmand is executad
successfylly.  For a few commands mentioned below, the response comes with the parameters requested and these commands are
configuration commands which may not be used by a MCU system.
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BM1250 RFID READER / WRITER MODULE

binory

Headsr Reserved Length Command Response CSUM

1 Byte | Byte 1 Byte 1 Byte N Byte 1 Byts

1. Header: This is a single byte that indicates the beginning of a frame.  This byte will be always 0xFF.

2. Reserved ® This byte is reserved for futtre Use and not implementead currently  1£ s Ox01

3 Length: This byte is used to indicate the length of the paylead data

4. Command : Thig is the command for which the response is being sent back. The host can use this byte to verify that ths
recgived response is for the command it sent

Response : This contains the data which may be a byte that indicales a successtul or faulty operation, or the parameters

mn

reguested
G, CSUM: This Is the chacksum byte: This is the sum of al bytes except the Header hyle

When a command is exgcuted successiully the returning response from the BM1250 devizeis - 04FF 0x01 0x01 0x9% 0x48
“0x99" means success operations and the 0x98 s the checksum

S| St I B ()
Tag data s passed to the nost as converted to ASCI characters. CR and LF will be added 1o the end of data.  For
example | If thetag containg data > 077553211, then

Incoming ASCII Characters »8977553311

{ AS HEX =0x39 0x39 Ox37 0237 0x25 0x35 0433 0x33 0x31 0x31 0x0D Ox0A )
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BM1250 RFID READER / WRITER MODULE

UART COMMANDS

BM1250 can he controlled over UART/Seral or there Is no necessary for a control mechanism once the Auto Read Mode is
setup. in Auto Mode, BM1250 runs automatically. continuously seek for tag, and does ot require any command to start read
operation. When atag is read it can output through UART.  Alternatively, BM1250 can be controlled by commands explained

below

CMD _READ

This comnrand starts standard read operation in BM1250.  The command requires two parameters. One parameter is the Made
{Read Type/Modulation Type) and the othet is number of blocks to B read. Respanse indicating sussesstul oparation is expected
mmediately Just after command is sent.  ifthe UART output is enabled, BM1250 will send tag data as s0on as the 1ag enters into the
field

Command CMD_READ 0x10

1 Byle — Mode or Type of Read

0x01 - Byte Track Mode — Manchester RFIG4

0402 ~ EM4102 Mode not-decoded(raw) - Manchester RF/&4
Mode ! Type 0x03 - EM4 102 Mode — Parity decoded — Manchester RF/64
0x04 - Byte Track Mods - Manchaster RF/32

Mode will be setto 0x03 automatically in the BM1250 device if it is
different than the above values

1 Byte — Number of total blocks 1o be read

For EM4102 Mode block number will be adjusted to 2
automatically in the BM1250 device

For Byte Track Mode, this srould be between 1 and 7. Valus
greater than 7 blocks will he agjusted ta 7 automatically in the
BM1250 device

Block Number

Example Command:
EM4102 Parity Decoded

TX > Read Tag FF 010310020218
RX = Success FF 010149998

OxFF Header

0x01 Fixed

0x03 Length of payload {Data + Command)

0x10 Read Command

0x02 Mode Byte (EM4102 Parity Decoded) {(Popular 125 KHz Read Type)
0x02 Block No

0x18 Checksum
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BM1250 RFID READER / WRITER MODULE

CMD SET BAUD RATE

Once you have finished setting the new baud rate. please resat module to communicate with the new baud rate.

Command
SET_BAUD_RATE

1 Byte — Baud Rale setting Valug
Qx00 - 9800

Qx01 - 19200 (Default)

0x02 - 30400

0x03 - 7600

%04 - 115200

Baud Rate

Example Command
Set to baud rate 9600

TA > Set Baud FF.01 02:52 00 85
RX » 5uccess FF 01011908

CMD STOP READ

This command stops reading cparation. There 1$ no parameter required for this command, Response indicating successful
operation is expected immediately just after command is sent.

Command
CMD_STOP_READ

12

Example Command;

TX >8top Read ' FF Q1011214
RX = Success FFO1 01 99898
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CMD _READ WITH PASS

binary

This command starts reading operation for a password protectad tag.  The password will be sent approximately each second to the

tag automatically. A tag thatis not passwond protected will also be read.  Response indicating successful operation Is expectad

mmeadiately just after command 1s sent

Command
CMD_READ _WITH_PASS

Dx13

Mode-£ Type

1 Byte — Mode or Type of Read

0x01 - Byle Track Mode = Manchester RFIG4
0x02 - EM4102 Mode not-decoded(raw) - Mancheaster RF/84
0x03 — EW4102 Modea — Farity decoded - Manchester RF/64
0x04 — Byte Track Mode — Manchester RF/32

Mode will be set to 0x02 automatically in the BM1250 device if it is
different than the above values

Block Number

1 Byte ~ Number of total blocks to be read

For EM4102 Mode block number will be adjusted to 2
automatically in the BM1250 device

For Byte Track Mode, this should be hetwsen 1 and 7. Valug
greater than 7 biocks will be adjusted 1o 7 automatically in the
BM1250 device

Password

4 Byle - Password
Nate that password Is the Biock7 of the tag data

Example Command:

TX > Read Tag w pass EF 01 07 13 01 02 10 20 30 40 BE
RX » Buccess FF 0101 99 98

OxFF Reader

Ox01 Fixed

ox07 Length of payload (Data + Command)

0x13 Read with password command

Ox01 Made { Byte Track mode ~ Manchester RF/64 is used)
Ox02 Biock No ( 2 block will be read = & byte }

Ox10 15t password hyte

0x20 2nd password hyte

0x30 3rdl password byte

Ox40 Ath password biyte

OxBE Checksum
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BM1250 RFID READER / WRITER MODULE

CMD WRITE
This command writes/programs given data to supported re-writeable tags. Supported rewriteable tags have 4 hyte in each Block
Q successiul aperation 15 expected Just after programming of

4 byte data can be wrtten o allowed tag blocks, Response indicatin
tag is done.  Unlike the other commands’ responses. the expected ‘success’ response can take longer (~500ms) to gel. The
CMD_WRITE function supports Q5 (TES55), TE557 and other re-writeable TS5xx tags

Please note that, a success response does not guarantee that the given data is writlen to the tag. A success response guarantee
that tag programming functions executed  The tag might not be programmed with the given data. User need to check manually by
reading the tag. Write distance, tag shape, size and type are important parameters that affsct writing

Command CMD_WRITE Dx20

1 Byte - Block number to be programmed

Please make sure you go cver Tag Programming section before
you program any hlock of the tag.  Incorrect writing may iock the
tag and make it useless.

Block Number 0x00 Configuration Block

0101 Block 1. Used for Byte Track

0x02 Block 2. Free Block

0x03 Block 3. Fres Block

(1«04 Block 4 Free Block

(X053 Block 5. Free Block

Ox08 Black 8, Free Block

0x07 Block 7. Password Block or Free Block

Data 4 Byte - Data to be programmead to the 1ag

Response:
Success: OxFF OxQ10x01 0x89 Dx4B
Response may arive with around 500ms delay

Example Command;

TX=FF 0106200220 2122 23 AF - Program Block2 with data: 20 21.22 23

2122
RX = Success FF 040185 98

OxFF Header
0x01 Fived

0x06 Lenath of paylcad (Data + Command)
0x20 Write Tag command

Ox02 Biock No (Block-2 will he written)
0x20 15t byte ta be programmed

0x21 2nd byte to be programmed
0x22 3rd byte to be programmed
0x23 4th byte to be programmed
Ox4F Checksum
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CMD _WRITE WITH PASS
This command 1s another version of CMD_WRITE command. It writes/programs given data to supported re-writeable tags with a

password  First password 1s sent then programming I petformed  Unlike the other commands’ responses, the expacted success’

response can take onger (~500ms) to gat

Please note that, a success response does not guarantes that the given data s writen to the tag. A success response guarantes that
tag programming functions executed. The tag might net he programmed with the given data  UJser need to check manually by
reacing the tag. Write distance, tag shape. size and type are imperant parameters that affect writing

Command
CMD_WRITE WITH_PASS

0x23

1 Byte — Block number to be programmed

Please make sure you go over Tag Programming section hefore
you program any block of the tag. Incorrect writing may leck the
tag and make tuseless.

0x00 Configuration Block.

0x01 Block 1. Used for Byte Track

002 Blagk 2. Free Block

003 Block 3. Free Block

0:04 Blotk 4. Free Block

0x05 Block 5. Free Block

0x06 Block 6. Free Block

0x07 Black 7. Password Block or Free Block

Block Number

Data 4 Byte - Data to be programmed to the tag
4 Byte — Password
Password L
Note that password (s the Biock7 of the tag data.
Responge
Sucecess: 0xFF 0x01 0201 0x99 098

Respanse may arrive with around 500ms delay
Example Command : #/Program Block2 with data; 20 21 22 23-with password: 10 20 20 40

TX>FFO¥0A2302202122231020304056
RX = Success FF 01 01 8958

0xFF Heager

0x01 Fixed

0x0A Length of payload (Data + Command)
0x23 Write with Password command
002 Black No (Block-2 will be written)
0x20 1st byte to be programmed

0x21 2nd hyte to be programmed
0x22 ard byte to be programmed

0x23 4th byte to be programmed

0x10 13t password byte

020 2ne password byte

0x30 3rd password byte

0x40 4th password byte

0x56 Checksum
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CMD SET AUTO MODE

This command enables or disables Auto Read Mode and detemines the necsssary parameters to be used in Auto Read Mode.

The parameters define the Mode (Read/Modulation type) to be used, number of blocks to be read and if it is necessary of not 1o send
password. Auto Read Mode brings advantage to user, so that external control of BM1250 may net be required. Once Auto Read
mode command is axecuted, the parameters are stored In non-volatile memory of the BM1250 device. Therefora it can

reliably be used in the fisld without need of extermal microcontroller to initiate read operations

Command
CMD_SET_AUTO_MODE

DxET

1 8yte - Auto Mode Enablz ¢ Dssbis

Auto Mode :
EnableDisanz 0x00 Bisables Auto Read Mode
0x07 Enables Auto Read Mode

1 Byt2 - Move or Type ¢f Read

=07 - Byte Track Mode — Manchester RF/E4
0502 — EM4102 Made naot-decodediraw) — Manchester RF/G4
Mode Ox032 - EM4102 Mode ~ Parity neeodes - Manchester RF 54
004 - Byte Track Mode - Manchester RF122

Mace wil pe set to Ix03 autematicay in the BM 1250 gevice 710

different tham thes above valuzs

1 Byte — Numiper of tota! blacks 1o be rzad

For ENM4102 Moo block nurnber will be adjustzc to 2

automaticaly inthe BMAYZ50 cevice

For Byte Track Mode, this should be between 18na 7

1 Byte — Password Enable / Disapis

Password ’
Enabi=Disats 0x00 Password is not seng
0x0*  Password is sent aprrosimatzy each second
4 Byte ~ Password
I the password 5 rot going to be ussa, random numizens can
Password be gven

Mete that Fasswera (s the dats storeg in Block7 of the tag
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BM1250 RFID READER / WRITER MODULE

Response:
Zuccess: CuFF 0x01 0x01 0x22 0x2B

Exarmnple Command
Enable Auto Read Mods — EM4102 Decoded Mods - No password

TX > 321 Auto Mode FFO103E87 01020200 10203045237
RX > Zuccess FFO1012028

OxFF Hezaer
Oxi3 Faed

o] Lerigth of payicad (Data + Command)
x87 Get Aute Mode Command

Cx1 Auto Mode is enables

03 Moz { ENG102 panty cecacad)

w02 Tetal blasi no to be reaa
iz sl D sable Password
Ox10 st passwers byts even 't isnot used

ox20 2nd password cyte even itis net used
Cx30 Srd password oyt 2ven itis not used
Cxsg 4t7 password byte gugn it 5 not uses
Ox37 Cheeksum

OMD RES
This commare resets EM1250 device.  Thers snoparamster required for this command  Responss ndicating suseessful oparation

is expectzd mmediately just aftercommand is sent.

Flzass note that if a read s stopped by CMO_STOP_READ command, and if Aute Ress Mode s enabled. 3fter 3 reset, automated

read cpetation wil stat again

Comireand
Ox51
CWD_STOP_READ
Example Cammand
TX > Reset FFO1D1E: §3
RX » Buccess FFO1D12298
OxFF Heager
Dx01 Fued
e Length of payload (Data + Command) (Here Data 's zerc byie in izngth)
Q251 Reset Command
Om53 Cheaksum
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binary

CMD _SLEEP

This command sencs sizeo commana to the ceviece to save powsr.  Dnee modu's enters into sleep moce, only extemal harware

reset or Powsr-Cri-Reset will wase up the BM1250 cavice

Commang

CMD_STOF_READ

Dxi

ponse;
cess: 0aFF Qul1 007 0200 2x28

Example Camimand.

| 082

TX > Sleep FF 01016
FF-01.01 00 0B

R¥X = Euccess

QxFF Header

0x01 Fixed

0x01 Lengt® of payleas iData + Command) (Here Data is 2er0 by'z inlength)
x50 Zleep Command

0462 Checksum

THEQRY OF READ OPERATION

There are two cptions for the read operation zceording to the miedulztion and the mathos used = the nag.

BM1220 suppors Manchestsr RF/84 and Manchester RF/32 modu stions. The Mancnester REIEL is the most ussd
medu'ation type in 125 KHz systams and is recommeanaczd to be used for new designs.  Manchester AF/32 s used insome
tags (=g TKEEEZ) out the read performance is lowsr than the Manchzster RF/24 anc net rscommendced for new designs.
ForManchester RF/64. signal representng tordis in 512 us wath for 125 Kz, For Manchestsr RFE2 signal
representing 1 or 0 is in 255 us wicth for 125 Kz EM2 102 tags vs2 Manchester REE4 modulaton and EM method and

the configuration of these read-cn'y tags s fixed snc can't be altered
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2 Byte Track Methoo
Whzther the modulation 's Manchestzr RF/32 or Manchesier RFIS4, when the tag is ensng zed in the magnete field across
the antenna. tag will be senc~g data censist of 15 and Os contnuously with no break or no sign for the header. To detect
the s1art sequencs of trz incom ng data there are two metheds.  One is the “oyts Tack” mathos and the other 5 "EM°
method  1FUByte Track” 5 uses, BM 250 device tracks 4 byte; 0x62 0x58 0188 Dx4% as cefaut. Thess seftings can be
changed. BM1250 devee can tracs for 1 byter 2 byte. 3 byte or 4 byts. The most reliatis and recommendes option 5 to
trace for 4 byte.  Note thatthe tracec byles should not regeat elsewh=r2 in th2 incom ng cata sirear, athenvise the
readerblock! syncaronizaton can b= wrong,  Please note that, f the 37 aoes notinclude bytes to te tracsq, then mattag
can notbe nead.  THSSx re-writeable tags neads to use Byte Track mzthod and 5o the first tlock reeds to be
wintten/programmed with the bytes to ba tracss.
Ineoming and contnuous data stream from the tag:
11110000011 120100 ...0504-0040 0103 12001000 10 110163010 . S001404061001 1111001

[Ox327[ 0«56 ] 0x88 ] [ Ond5 }
TEE5x Tags send data as fol'ows
{Example is given far 3 biocks is transmittec by the tag. Each block has ¢ byte data)
[ [Bloek 1]{Block Z | [ Biock 2| [Block 1]{Block 2] [ Block 3 | [ Block 1] f-]

Block1 shawid o= pregrammed with 0552 0x38 0xEE 0x45 50 that when BM1Z5 calch thess tytes, 4 will be syncaronizza
and assurne 0x62 0u58 0x58 0545 35 the first blogk

Hotes

Block 0 Feor TS55Z (Q5). conPguraton Block must contain 0x30) B0 1, OxFD, Ox0E
Fuor TEEE7, TH5E7. configuraton Bock must contain 0x00, Ox 14, Dx30, OxED
corresponas to Manchester RE/G4  transmit of 7 block (Block . 7).
BlockD s=ould not be programmes wih arbitrary va/ues pthenwse tha tag may not be accessad again,
Block 1 Trus block can be usea for “Byte Track” method. What is programmed in this blosk should be traced oy BM1250.
BN 1280 oevice tracks 4 byt=; 052 DxEB D638 OxdS as default

Block 2-8 General purpose ¢ata bock. Writing toths block is safe No gars requirss,

Block 7 Tns block can be usso as g=reral purpose data block or can te wsed aspassword.  If password is enableg,
access ko the tag requires the password that matehes Bock? content.  Once passwond is enadled and if the

blockT data is unknown then it 5 mpossitle to 3ocess the tag aga n unless wih the cormect 4 byte passwerd.
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Ma > -
Whether the medulaton is Manchester RF/32 o Manshsester RF/E4, when the 1ag is energizad in the magnstic field across
the antznna, tag wil te sending data consst of s and Os continuzusly with ne break o no sign o the neader.  To detect
the =tart sequence of the incaming data there is ancther methed cales "EMA102" methos. This method s used in EN4102
fags ana generally uses Manchester RF/GS mocuaton. Inthis mage, instead of racng bytes explaned » seetion 2.1,
nns 1 [T111 7111 1) are traced to detsct the beginnng of the dats sequence  Moreover the cata wotten = the tag is
created with party ©4s sothateven 3 taghas nine 15, the reaa operationwill not be suzcessful  the parnites do not maten

EM#102 tags consst of 2 blocks each have 4 byte. Thasz 6 bytes include nine Tseactialaatathar s the & byt
izentification ¢oo2 and the row and column parity bits.

TI00L00. 1111 110110001 181001001 1 21 5001
Hesoer | [ Party cocedeats

EM2102 t3g sends dsia as follows:

=] [Bloek ¥ ][ Block 2] [ Block 1 1 Bloek 2T =]
Pieass nete that, the aclua idenfifeation cods is § Bytes in EM4102 tag WWith the rine ores and parity bits the raw data s
two blacks zach 4 byle. Panity check wll e donz by BM 1230 autematcally and if panty bits do ot mateh then thers won't

be any output and BMIZED keep tryng to read. Torgetthe actual 5 byte data, use "EM4102 decoded” opten. Togetts
raw £31a including nine ones ana panty bits uss "EM4102 raw data” ootion.
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! Product Overview

The Arduino Mega 2560 is a microcontroller board based on the ATmega2560
(datasheet). It has 54 digital input/output pins (of which 14 can be used as PWM outputs),
16 analog inputs, 4 UARTSs (hardware serial ports), a 16 MHz crystal oscillator, a USB
connection, a power jack, an ICSP header, and a reset button. It contains everything
needed to support the microcontroller; simply connect it to a computer with a USB cable or
power it with a AC-to-DC adapter or battery to get started. The Mega is compatible with
most shields designed for the Arduino Duemilanove or Diecimila.
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Technical Specification

EAGLE files: arduino-mega2560-reference-design.zip Schematic: arduino-mega2560-schematic.pdf

Summar

Microcontroller ATmega2560

Operating Voltage 5V

Input Voltage (recommended)  7-12V

Input Voltage (limits) 6-20V

Digital I/O Pins 54 (of which 14 provide PWM output)
Analog Input Pins 16

DC Current per I/O Pin 40 mA

DC Current for 3.3V Pin 50 mA

Flash Memory 256 KB of which 8 KB used by bootloader
SRAM 8 KB

EEPROM 4 KB

Clock Speed 16 MHz

ARDUINO
ANALOG IN

§85 239332.%

lanalog pins|

RS radiospares mapiomcs 4.!



The Arduino Mega2560 can be powered via the USB connection or with an external power supply. The power source is
selected automatically. External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The
adapter can be connected by plugging a 2.1mm center-positive plug into the board's power jack. Leads from a battery
can be inserted in the Gnd and Vin pin headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V pin may
supply less than five volts and the board may he unstable If using more than 12V, the voltage regulator may overheat
and damage the board. The recommended range is 7 to 12 volts.

The Mega2560 differs from all preceding boards in that it does not use the FTDI USB-to-serial driver chip. Instead, it
features the Atmega8U2 programmed as a USB-to-serial converter.

The power pins are as follows:

[l VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to 5 volts
from the USB connection or other regulated power source). You can supply voltage through this pin, or, if
supplying voltage via the power jack, access it through this pin.

L' 5V. The regulated power supply used to power the microcontroller and other components on the board. This
can come either from VIN via an on-board regulator, or be supplied by USB or another regulated 5V supply.

[] 3V3.A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA.

[] GND. Ground pins.

The ATmega2560 has 256 KB of flash memory for storing code (of which 8 KB is used for the bootloader), 8 KB of
SRAM and 4 KB of EEPROM (which can be read and written with the EEPROM library).

Input and Outfput

Each of the 54 digital pins on the Mega can be used as an input or output, using pinMede(), digitalWrite(), and
digitalRead() functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA and has an
internal pull-up resistor (disconnected by default) of 20-50 kOhms. In addition, some pins have specialized functions:

[l Serial: 0 (RX) and 1 (TX); Serial 1: 19 (RX) and 18 (TX); Serial 2: 17 (RX) and 16 (TX); Serial 3: 15 (RX) and
14 (TX). Used to receive (RX) and transmit (TX) TTL serial data. Pins 0 and 1 are also connected to the
corresponding pins of the ATmega8U2 USB-to-TTL Serial chip .
L External Interrupts: 2 (interrupt 0), 3 (interrupt 1), 18 (interrupt 5), 19 (interrupt 4), 20 (interrupt 3), and 21
(interrupt 2). These pins can be configured to trigger an interrupt on a low value, a rising or falling edge, or a
change in value. See the attachinterrupt() function for details.
PWM: 0 to 13. Provide 8-bit PWM output with the analogWrite() function.
SPIL 50 (MISQ), 51 (MOSI), 52 (SCK), 53 (SS). These pins support SP| communication, which, although
provided by the underlying hardware, is not currently included in the Arduino language. The SPI pins are also
broken out on the ICSP header, which is physically compatible with the Duemilanove and Diecimila.
LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is on, when
the pin is LOW, it's off.
:C: 20 (SDA) and 21 (SCL). Support I2C (TWI) communication using the Wire library (documentation on the
Wiring website). Note that these pins are not in the same location as the I.C pins-onrthe-Buemilanove.

(.

The Mega2560 has 16 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By default
they measure from ground to 5 volts, though is it possible to change the upper end of their range using the AREF pin and
analogReference() function.

There are a couple of other pins on the board:

LI AREF. Reference voltage for the analog inputs. Used with analogReference().
[0 Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to shields which
block the one on the board.

: 4
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Communication

The Arduino Mega2560 has a number of facilities for communicating with a computer, another Arduino, or
other microcontrollers. The ATmega2560 provides four hardware UARTS for TTL (5V) serial communication.
An ATmega8U2 on the board channels one of these over USB and provides a virtual com port to software on
the computer (Windows machines will need a .inf file, but OSX and Linux machines will recognize the board
as a COM port automatically. The Arduino software includes a serial monitor which allows simple textual
data to be sent to and from the board. The RX and TX LEDs on the board will flash when data is being
transmitted via the ATmega8U2 chip and USB connection to the computer (but not for serial communication
on pins 0 and 1).

A SoftwareSerial library allows for serial communication on any of the Mega's digital pins.

The ATmega2560 also supports 12C (TWI) and SPI communication. The Arduino software includes a Wire
library to simplify use of the 12C bus; see the documentation on the Wiring website for details. To use the SPI
communication, please see the ATmega2560 datasheet.

Programming

The Arduino Mega2560 can be programmed with the Arduino software (download). For details, see the
reference and tutorials.

The Atmega2560 on the Arduino Mega comes preburned with a bootloader that allows you to upload new
code to it without the use of an external hardware programmer. It communicates using the original STK500
protocol (reference, C header files).

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial
Programming) header; see these instructions for details.
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' Automatic (Software) Reset

Rather then requiring a physical press of the reset button before an upload, the Arduino Mega2560 is
designed in a way that allows it to be reset by software running on a connected computer. One of the
hardware flow control lines (DTR) of the ATmega8U2 is connected to the reset line of the ATmega2560 via a
100 nanofarad capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the
chip. The Arduino software uses this capability to allow you to upload code by simply pressing the upload
button in the Arduino environment. This means that the bootloader can have a shorter timeout, as the
lowering of DTR can be well-coordinated with the start of the upload.

This setup has other implications. When the Mega2560 is connected to either a computer running Mac OS X
or Linux, it resets each time a connection is made to it from software (via USB). For the following half-second
or so, the bootloader is running on the Mega2560. While it is programmed to ignore malformed data (i.e.
anything besides an upload of new code), it will intercept the first few bytes of data sent to the board after a
connection is opened. If a sketch running on the board receives one-time configuration or other data when it
first starts, make sure that the software with which it communicates waits a second after opening the
connection and before sending this data.

The Mega contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can
be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset
by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details.

USB Overcurrent Protection

The Arduino Mega has a resettable polyfuse that protects your computer's USB ports from shorts and
overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer
of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection
until the short or overload is removed.

Physical Characteristics and Shield Compatibilit

The maximum length and width of the Mega PCB are 4 and 2.1 inches respectively, with the USB connector
and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to
a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple
of the 100 mil spacing of the other pins.

The Mega is designed to be compatible with most shields designed for the Diecimila or Duemilanove. Digital
pins 0 to 13 (and the adjacent AREF and GND pins), analog inputs 0 to 5, the power header, and ICSP
header are all in equivalent locations. Further the main UART (serial port) is located on the same pins (0 and
1), as are external interrupts 0 and 1 (pins 2 and 3 respectively). SPI is available through the ICSP header on
both the Mega and Duemilanove / Diecimila. Please note that I.C is not located on the same pins on the

Mega (20 and 21) as the Duemilanove / Diecimila (analog inputs 4 and 5).

s
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How to use Arduino

communicate with software on running on a computerse.g. Flash, Processing, MaxMSP).

Arduino can sense the environment by receiving input from a variety of sensors and can affect its
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is
programmed using the Arduino programming language (based on Wiring) and the Arduino

development environment (based on Processing). Arduino projects can be stand-alone or they can

Arduino is a cross-platoform program. You'll have to follow different instructions for your personal
OS. Check on the Arduino site for the latest instructions. http://arduino.cc/en/Guide/HomePage

Linux Install Windows Install Mac Install

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.

' Blink led

Now you're actually ready to “burn” your
first program on the arduino board. To
select “blink led”, the physical translation
of the well known programming “hello

Iﬂuum« | Arduino 0017
Fle Edt Sietsh  Todls hHelp

®® CEEEE

world”, select
it ledPin = 13: W ¢ CBD corrected flgieal pin 173
3 FATHE et Y aorhad P
File>Sketchbook>
Arduino-0017>Examples> S et ol - €
Digital>BIink ] paaliode | 1edbin, OUTPIT) 2
Once you have your skecth you'll s aacadl ox Dt Tons S
see something very close to the ..
. NOOr nop
screenshot on the right. f
dagatallis:ta|ledPin, HIGH):
delay | 1000)
In Tools>Board select MEGA et & AR

Now you have to go to
Tools>SerialPort

and select the right serial port, the
one arduino is attached to.

‘ Iione corﬁ?p-iling. ‘

Press Compile button ]
(to check for errors) Upload TX RX Flashing Blinking Led!
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Dimensioned Drawing
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Terms & Conditions (OO

1. Warranties

1.1 The producer warrants that its products will conform to the Specifications. This warranty lasts for one (1) years from the date of the sale. The

praducer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including improper installation or testing,
or for any products that have been altered or modified in any way by a Customer. Moreover, The producer shall not be liable for any defects that result from
Customer's design, specifications or instructions for such products, Testing and other quality control techniques are used to the extent the producer deems

necessary.

1.2 If any products fail to conform to the warranty set forth above, the producer’s sole liability shall be to replace such products. The producer's liability
shall be limited to products that are determined by the producer not to conform to such warranty. If the preducer elects to replace such products, the
producer shall have a reasonable time to replacements. Replaced products shall be warranted for a new full warranty period,

1.3 EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." THE PRODUCER DISCLAIMS ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE
1.4 Customer agrees that prior to using any systems that include the producer products, Customer will test such systems and the functionality of the

products as used in such systems. The producer may provide technical, applications or design advice, quality characterization, reliability data or other
services. Customer acknowledges and agrees that providing these services shall not expand or otherwise alter the producer's warranties, as set forth

above, and no additional obligations or liabilities shall arise from the producer providing such services.

1.5 The Arduino™ products are not authorized for use in safety-critical applications where a failure of the product would reasonably be expected to cause
severe personal injury or death. Safety-Critical Applications include, without limitation, life support devices and systems, equipment or systems for the
operation of nuclear facilities and weapons systems. Arduino™ products are neither designed nor intended for use in military or aerospace applications or
environments and for automotive applications or environment, Customer acknowledges and agrees that any such use of Arduino™ products which is solely
at the Customer’s risk, and that Customer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

1.6 Customer acknowledges and agrees that it is solely respansible for compliance with all legal, regulatery and safety-related requirements concerning its
products and any use of Arduino™ products in Customer's applications, notwithstanding any applications-related information or support that may be

provided by the producer.

2. Indemnification

The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against any and all third-party losses, damages,
liabilities and expenses it incurs to the extent directly caused by: (i) an actual breach by a Customer of the representation and warranties made under this

terms and conditions or (ii) the gross negligence or willful misconduct by the Customer,

3. Consequential Damages Waiver

In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental, consequential or
exemplary damages in connection with or arising out of the products provided hereunder, regardless of whether the producer has been advised of the

possibility of such damages. This section will survive the termination of the warranty period.

4. Changes to specifications

The preducer may make changes to specifications and product descriptions at any time, without notice. The Customer must not rely on the absence or
characteristics of any features or instructions marked "reserved" or "undefined.” The producer reserves these for future definition and shall have no
responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The product information on the Web Site or Materials is
subject to change without notice. Do not finalize a design with this information.

Enviromental Policies

The producer of Arduinod has joined the Impatto Zero®
policy of LifeGate.it. For each Arduino board produced is
created / looked after half squared Km of Costa Rica's

forest's.
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